Looking for schedule variances

The tips and tricks below are taken from Project Mentor, the smart way to learn Microsoft Project. For further information, please go to:

www.projectlearning.net/project_mentor.htm

More useful tips and tricks can be found on the Project Learning blog:

www.projectknowledge.net

Related Document(s)
Filtering & grouping by schedule status
www.projectlearning.net/pdf/I1.2.pdf
Looking for schedule variances

Introduction

Planning a project is one thing; managing a project effectively is often something completely different, and with its own set of challenges. Of the Microsoft Project users that track actual progress against project tasks, disappointingly few understand how to compare a planned schedule with what actually happened. These users are probably unaware of the wealth of information available to them, and the value they can get from correctly interpreting that information.

These tips and tricks illustrate a number of ways that schedule comparisons can be made, together with how the information available can be interpreted.

Background

Before replanning a project, a comparison should be made between the project's current schedule and baseline information. A simple comparison can determine: If any slippage has occurred; the tasks that exhibit the slippage or the amount of slippage that exists. The project's schedule is normally compared to the overall baseline for the plan (which is usually agreed between the Project Manager and the Project Sponsor). The schedule can also be compared with interim baselines to determine any changes since a previous project update. These comparisons can be invaluable, as they can highlight trends occurring within the project that may be missed by simply looking at a project's critical path.
Looking for schedule variances

Making baseline comparisons

When a project has been updated with progress, there will invariably be differences between the current schedule and its baseline. This can be seen most clearly within the Tracking Gantt view. In the example below, the nonworking time from Tim Brown's resource calendar has been added for clarity.

The view above is indicating:

- Design structure started and finished on time. The baseline bar and the actual bar for this task are scheduled identically.
- Write body text started on time and is split. It is scheduled to finish very late due to a resource calendar affecting when work upon the task can resume.
- Set page layouts is delayed because of its late-running predecessor.
- Create exercises started early and it finished early.
- Test exercises started and finished early, well before its deadline date.
- Create contents & index has a delayed predecessor, so it too is delayed.
- The milestone Manual completed has not been rescheduled because of its delayed predecessor.

Hints
- If tasks were delayed beyond deadline dates, an indicator could show a warning message.
- If milestones (or indeed any tasks) appear earlier than the finish of their predecessor(s), they probably have an inflexible constraint against them. If so, a scheduling conflict probably exists.
Quantifying schedule variances

Whilst a simple visual comparison is useful, there are ways to make a more meaningful comparison between the current schedule and the baseline. Fields within the Variance table provide this information:

- From the View menu, select Table and then select Variance:

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Start</th>
<th>Finish</th>
<th>Baseline Start</th>
<th>Baseline Finish</th>
<th>Start Var.</th>
<th>Finish Var.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Project</td>
<td>Feb 2 '04</td>
<td>Mar 21 '04</td>
<td>Feb 2 '04</td>
<td>Mar 21 '04</td>
<td>0 days</td>
<td>1 day</td>
</tr>
<tr>
<td>Weekly meetings</td>
<td>Feb 2 '04</td>
<td>Mar 22 '04</td>
<td>Feb 2 '04</td>
<td>Mar 22 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Content</td>
<td>Feb 2 '04</td>
<td>Mar 19 '04</td>
<td>Feb 2 '04</td>
<td>Mar 19 '04</td>
<td>0 days</td>
<td>6 days</td>
</tr>
<tr>
<td>Text body text</td>
<td>Feb 9 '04</td>
<td>Mar 13 '04</td>
<td>Feb 9 '04</td>
<td>Mar 13 '04</td>
<td>0 days</td>
<td>12 days</td>
</tr>
<tr>
<td>Set page layouts</td>
<td>Mar 15 '04</td>
<td>Mar 15 '04</td>
<td>Mar 15 '04</td>
<td>Mar 15 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Exercises</td>
<td>Feb 11 '04</td>
<td>Mar 24 '04</td>
<td>Feb 16 '04</td>
<td>Mar 19 '04</td>
<td>-5 days</td>
<td>3 days</td>
</tr>
<tr>
<td>Create exercises</td>
<td>Feb 11 '04</td>
<td>Feb 13 '04</td>
<td>Feb 11 '04</td>
<td>Feb 13 '04</td>
<td>-3 days</td>
<td>-5 days</td>
</tr>
<tr>
<td>Test exercises</td>
<td>Feb 23 '04</td>
<td>Feb 27 '04</td>
<td>Mar 1 '04</td>
<td>Mar 5 '04</td>
<td>-5 days</td>
<td>-5 days</td>
</tr>
<tr>
<td>Create contents &amp; index</td>
<td>Mar 19 '04</td>
<td>Mar 24 '04</td>
<td>Mar 19 '04</td>
<td>Mar 19 '04</td>
<td>3 days</td>
<td>3 days</td>
</tr>
<tr>
<td>Manual completed</td>
<td>Mar 23 '04</td>
<td>Mar 23 '04</td>
<td>Mar 20 '04</td>
<td>Mar 22 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
</tbody>
</table>

- If a task has a positive start variance: Its scheduled start is later than its baseline start.
- If a task's start variance is a negative value: It started earlier than its baseline.
- If a task has a positive finish variance: Its scheduled finish is later than its baseline finish.
- If a task's finish variance is a negative value: It finished earlier than its baseline.

Hints

- Start variances and finish variances for summary tasks reflect their baseline performance. In the example above the Content summary task above started on time, but is expected to finish six days late. The Exercises summary task started three days early, but is expected to finish three days late.
- When tasks have a finish variance greater than their start variance, they are overrunning; they are expected to take longer to complete than originally planned. These tasks may well have cost variances associated with them as well.
Looking for schedule variances

Quantifying changes to slack values

Schedule comparisons can also be made with slack values that tasks possess. These fields can be found within the Schedule table:

- From the View menu, select Table and then select Schedule:

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Start</th>
<th>Finish</th>
<th>Late Start</th>
<th>Late Finish</th>
<th>Free Slack</th>
<th>Total Slack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Project</td>
<td>Feb 2 '04</td>
<td>Mar 14 '04</td>
<td>Mar 24 '04</td>
<td>Mar 24 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Weekly meetings</td>
<td>Feb 2 '04</td>
<td>Mar 14 '04</td>
<td>Mar 24 '04</td>
<td>Mar 24 '04</td>
<td>2.75 days</td>
<td>2.75 days</td>
</tr>
<tr>
<td>Content</td>
<td>Feb 2 '04</td>
<td>Mar 14 '04</td>
<td>Mar 24 '04</td>
<td>Mar 24 '04</td>
<td>0 days</td>
<td>-1 day</td>
</tr>
<tr>
<td>Design structure</td>
<td>Feb 2 '04</td>
<td>Feb 04 '04</td>
<td>Feb 04 '04</td>
<td>Feb 04 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Write book draft</td>
<td>Mar 9 '04</td>
<td>Mar 13 '04</td>
<td>Mar 13 '04</td>
<td>Mar 13 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Set page layouts</td>
<td>Mar 15 '04</td>
<td>Mar 19 '04</td>
<td>Mar 19 '04</td>
<td>Mar 19 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Exercises</td>
<td>Feb 11 '04</td>
<td>Mar 21 '04</td>
<td>Mar 23 '04</td>
<td>Mar 23 '04</td>
<td>0 days</td>
<td>-1 day</td>
</tr>
<tr>
<td>Create exercises</td>
<td>Feb 11 '04</td>
<td>Feb 20 '04</td>
<td>Feb 20 '04</td>
<td>Feb 20 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Test exercises</td>
<td>Feb 23 '04</td>
<td>Feb 27 '04</td>
<td>Feb 27 '04</td>
<td>Feb 27 '04</td>
<td>0 days</td>
<td>0 days</td>
</tr>
<tr>
<td>Create contents &amp; index</td>
<td>Mar 16 '04</td>
<td>Mar 17 '04</td>
<td>Mar 17 '04</td>
<td>Mar 17 '04</td>
<td>0 days</td>
<td>-1 day</td>
</tr>
<tr>
<td>Manual completed</td>
<td>Mar 23 '04</td>
<td>Mar 23 '04</td>
<td>Mar 23 '04</td>
<td>Mar 23 '04</td>
<td>0 days</td>
<td>-1 day</td>
</tr>
</tbody>
</table>

- If tasks are completed or are critical: Their total slack value will be 0.
- If any tasks can be delayed without affecting the project finish date or a task with an inflexible constraint: Their total slack value will be positive.
- If a scheduling conflict exists: Tasks will have a negative total slack value.

Hints

- Where negative slack values are displayed against tasks, the sequence of tasks needs to be performed quicker in order to meet the project finish date or an inflexible constraint. In the example above, a saving of one day on EITHER Set page layouts OR Create contents & index would be enough to bring the project back on schedule and reduce the total slack to be 0 days.
Looking for schedule variances

Making comparisons to interim baselines

Schedule comparisons can also be made against interim baselines (plans). This can provide a comparison with the project's schedule prior to the latest update. In order for this to be possible, some simple procedures should be adopted:

• Before updating the project with progress, create an interim baseline (plan). This will copy the current schedule into the interim baseline value:

  a. From the Tools Menu, select Tracking and then select Save Baseline.
  b. Set to copy the scheduled start into Start1 and the scheduled finish into Finish1 for all tasks, confirmed with OK.

• Repeat the process before each update to the project.
Once interim plans have been created, comparisons can be made against them:

- Use the Table Definition dialog box to create custom tables that display appropriate fields:

![Table Definition dialog box](image)

- Create new views that contain custom bar styles to display the latest interim baseline status compared to the current schedule:

![Bar Styles](image)
Looking for schedule variances

- The bar style for baseline bars has been replaced with a bar style for the third interim baseline (Start3 / Finish3):

- Where there is a variance between the 'Interim 3' bars and the normal task bars, a slippage will have taken place as a result of the 'Interim3' update to the project (for example, Write body text, Set page layouts and Create contents & index have all slipped).

**Hints**

- Before updating a project with ANY actual progress, consider the update frequency. This will determine when each change of status date should take place. Ensure that the project team is aware of every status date and hence when the updates will be performed.
- Create calculated fields to compare interim baseline values with current schedule values; for example to determine a variance between a scheduled finish date and the 'Finish 4' field. This would allow comparison with the project at its fourth change of status date.
- Up to 4 rows of bar styles can be displayed. This can provide a very detailed schedule comparison (if required):
Looking for schedule variances

**Adding progress lines to a Gantt chart**

Another way that progress can be measured is by the addition of progress lines to a Gantt chart. These progress lines can be used for a graphical representation of task slippage. To apply progress lines:

a. From the Tools menu, select Tracking and then select Progress Lines.

b. Select to show a progress line based upon the project's status date:

![Progress Lines dialog box](image)

- Confirm with OK to display:

  - The progress line for Write body text has been drawn back behind the status date. This indicates that the task is behind schedule.
  - The progress against the two summary tasks is rolled up from their subtasks. The summary tasks are described as being ahead of schedule.
### Looking for schedule variances

<table>
<thead>
<tr>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Multiple progress lines can be added, for example at each change of status date.</td>
</tr>
<tr>
<td>• The style of progress lines can be defined within the ‘Line Styles’ tab of the Progress Lines dialog.</td>
</tr>
<tr>
<td>• Progress line display can be selected as well as cleared within the Progress Lines dialog.</td>
</tr>
</tbody>
</table>